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Opcode Patch Editor:
Yamaha DX/TX Synthesizers

Manual for the Opcode DXITX FEditor/Librarian VCISI100
(Editor v. 1.20ecl+)
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Introduction

(hverview

IT you own a Yamaha programmable digital FM synthesizer, you are undoubiedly
well aware that it is copable of producing sounds which are superior 1o just abou
any other synthesizer available. However, programming these sounds is not nearly
as easy as enjoying them, Opeode Paich Edior is a program that uses the power of
the Macintosh wo ease the complexity of ereating I'M sounds, or patches. “Patch™ 1sa
misnomer Tor digital machines such as the DX7, since no hardware elements are
being hooked up with patch cords. What you are really doing is playing with
nimbers (called pargmeters) ina recipe (called an algorithm). The Patch Editor can
show you all the parameters on the Macintosh screen at once, unlike the DX7, which
vnly displuys one at o time,

If you own a TX816 or TX7 synthesizer, o system such as Opeode Paich Editor is
required w do any kind of programming, unless you also own a X7, You edit the
sounds in real time aml can even “play” your synthesizer by hiting keys on the
Macintosh keyboard, or record an example scquence on your MIDT synthesizer
kevboard and play it back at the wuch of a key, or if you desire, every time you
make a change o the patch, Values are displayed graphically, and you can “draw™
envelopes and keyboard scaling curves in a manner simibar (o drawing pictures in
MacPaini.
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Wivw Din Boeadd this AEanual

This manual is designed w be of use 0 people with differing backgrounds and levels
of expenience in FM synthesis progranmng and the use of 4 X7, The sereen
might be rather intimidating il you're not familiar with programming the DX
however you should be able 1o play around with it immediately without hurting
anything (perhaps the neighbors” ears). However, if you have DXT expernence; il
should be quite apparent how the program works, and you may never need 1o refer
1o this document imore than a couple of times,

I you alieady feel that you're a DXT expent and have a lot of Macintosh experience,
the essential thing is getting the computer, software, interface, and synthesizer set up
in the right way. This infoomation can be found in the Pach Librarian mannal. You
might want 1o then review the Patch Editor Menus section 1o leam some of the
advanced features of the program, such as Copying and Pasting operations.

If your own a TX but not a DX7 and need 10 know what “programming is all about.
you should definitely go through all the tutorials, 've tried to include just ahswt all
of the infonmation in the DX7 manual to get you staried. The other thing to do is
look at the voices that came with your machine, and also at the Tutorial Examples file
included on the Paich Editor disk.

If you've done a lite DX7 programming but were frusirated and have never really
spent a lot of time with the process, you should also go toromgh the totorials,
although you may be able 1o skip the first one. You'll also find the reference seciion
helplul, especially the explanations of the Voice Parameters and Performance
Parnmelers,
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Gietting Started
Starting from the Librarian
To start the Patch Editor, you select a patch you want to Edit and then click on the

Edit button (shown below) in a Pach Librarian DXT, TX, or TXEI6 Bank o
Library window,
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The first time the Editor is called, the screen will initialize and the cursor will
into a colfee cup (telling you w go get a cup of coffee instead of just staring at your
watch), After a few seconds, the windows of the Editor will appear with all the
information about the patch you selected. In addiion, the patch should have been
sent 1o your synthesizer. I this doesn’t appear to be the case check to see that the
proper steps have been taken to set up the synthesizer. These appear on the screen
the first time you open a window for a particalar kind of synthesizer and are also
found in the Librarian manual.
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Iistening o yoonr sounds

Frnyprar st fip

Mow that you have a sound loaded into the Editor, let’s hsten o it, 17 you have a
piane-like keyboard (such as the one on a DX7). you should now he able 1o play the
sontid in the Editor by hittiog the keys. You can also use the Macintosh iypewriier
kevboard as o MIDI Keyboard. Tt a Tew of the letier keys woward the left side of the
keyboard. The note is held as long as you hold the key down, and stops when you
lift your finger. The keyboard is arranged w play the © seale in sis oviaves, To pet
the lower three octaves, press the Caps Lock key (nof the Shilt key —noles tend 1o
get "stuck™ i you Ky up the shift key at the wrong time). The lowest row of keys
(ZXCV etc.) is pretty low!

There is also the Play/Record menu {also available in the Librarian), within which
lurks a tiny MIDI sequencer, 1 you have a MIDI keyboard connecied 1o the
Macintosh (1the one on the X7 does nicely), select Record Example from this
ment. You will see o dialog box that Jooks like this:

Recording: Hit mouse button or any key 1o stop

Start playing an avant-garde melody on your keyboand. There's no hurry to oy 500
because hitting the first note starts the “tape” rolling. The melody can only consist of
about 200 MIDI events {that's about 1K) notes) but you'll see that's plenty lor the
purposes of this program,

When you're done, hit the mouse button.  Mow let’s listen w0 it Select Play
Example from the Mlay/Record menu, You should be heanng exactly what you
pliyesd,

it the mouse bution or any key while the sequence is playing and it will stop

immedaicly. You'll soon find out that you don't want to hear this sequence over and
over apain in its entirety when you're editing a voice,
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Selecting voives

Pull diwn the Yoice menu, You will see the names of all the voices in the Pank o
Library window you're working with. To listen 1o another vonce, just select iis
natmie from the menu. The new voice’s data are displiyed on the sereen amd senl to
the synthesizer. So select a new voice and try your classic Example Sequence on i
by selecting May Example,

store Current Ldit %S

1 My Hat 17 Pepsi |

2 Clarinetle 18 Nukelizast
3 Keltles 19 Girflend

4 ChikScrich 20 Klerfend

5 Guitar 21 Perifend

6 Organic 22 UoiceDTH

7 Cow Ding 23 Glamelan

8 OrngeCrsh 24 Gameshow
9 DublBubhble 25 Dilcan Joe

10 Cavalero

11 For a good
12 time call

13 41532189
14 BassFshing
15 BowTie34
16 Governmen!

26 Noltoofost
27 JealousMe
28 Unnamed
29 Hisimnge
30 Hi Jeff

31 FargoND
32 Drugbust

Returning to the Librarian

To return to the Librarian, select Exit from the File menu, You'll need 1o du this to
it the Editor/Librarian and return to the Finder. You can switch back and forth
hetween the two programs with the Edit button and the Exit command as much as
you like. After the Editor has been initialized, switching is quite rapid.
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Fehiting

Menu {verview

Apypile

File

Felir

Tn this wutorial, we'll take a quick Jook at how the editor screen 1 arranged amd point
oul some key locations. Then you'll leam the basic technigues needed o create anid
cdit your own DXSTX voices with the MIDIMAC Pawch Editor. First though, my
apologies for the screen.  Centainly it is one of the most cunu_mlu;aml anil
overwhelming Macintosh screens around,  However, once you ve hecome
accustomed 10 where everything is, you'll appreciate being able o scan so much
information at once. 1 think that having a complete picture of the sound avinlable 1o
you at all times will be a big help in coming up with ideas about whal @ Iry next
while you're working. Below is i rough sketeh of how the screen is organized

Operator Windows

1 2 3 4 5 5]

H—

Global Window I\?cl:?g; ﬂgma

Scroll Bar Window

Global T ] |
Window

Envelope Window,
Graphical Keyboard Scaling,
Function Sellings

& File Edit Doice Function Record/Play

Thizs meny containsg the About box with the Copyright notice and any Desk
Accesories you might have in your systen.

This mmenu allows you

+ Uil the settings of the INTT VOICE

s Load a voice from your symhiesizer inta the Editor

+ Save the current Bank or Lilwary in a file

« Print out the sewings of the corremly edited voice or an entine Bank or Library

Thas menu allows vou w make cenin kinds of changes to the cumrently edited vonce
sunnilar fo those you g bt doom o weond processor,
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Uperator Windows

This menn displays the names of all voices in the curtent Rank o Library Tile and
allows you 1o select a new one for editing, or make a copy of what you're working
wilh o a new location o a Bank.

This menu is allows you edit the TX Performance parameters. Il you have a DXT,
you can simulate the TXs management of your DX7's Tan Function setiings here,

This menu, similar o the one in the Librarian, allows you 1o record and play back a
short example sequence 1o test out your editing.

Below the menus are six Operator Windows. These correspond 1o the six glorified
diginal sine wave oscillators, or Operators, in your synthesizer, Al parameters of the
sound which are specific w an Operator are located here. For example, it's clear that
cach Operator has an envelope, deawn near the top of the window, You'll select a
muymber {or picture, in the case of an Envelope or Keyboard Scaling curve) in this
window when you want to chinge its volue,

[F tod (R |
[\

Vel RSe "“'.1
1 I 1 | 0
M Coar Fine Del
r—[ . |50 |0

TT
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Colohiad Windoows

Helow the Operator Windows are parameters which apply 1o the entire patch, not jusi
to an individual Operator,  We'll refer to these as Global parameters, amd they
include the conliguration of Operators; what Yamaba calls an Algorithm,. A diagram
of the current algorithm is provided for you on the lef side of the screen. Cther

examples of global parameters are the Piich Envelope and the Low Freguency
Orseillator (LFO),

PEGRat|99[99]99 99 LFOWave Spd Del FHD AMD PHS Syne
PEGLev|50 |50 [50]50 | trianat [35] 0] 0 | o | 3 | on

quriihmr_'l

KeyTP| c3
Feedback| O

EeySyne | On

Scroll Bar Window S, NS =

The Scrall Bar Window is one place where you'll be spending o lot of time. It
functions as a4 replacement for the Data Entry slider knob on a DXT, However, |
think it is superior in many respeets w the DXT's slider, Motonly does it show you
the mame of the parameder you're changing, but it automatically puts the “thnb™ tthe
lintle white box) at the current setling of the parameter, 11 also shows you the
possible maximum and minimum values for any paramcter. We'll discuss this
window in more detail a little bt lnier, but if you're Bumiliar with Macintosh seroll
bars, by all means iry it ot now,
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Thoss to Balil:

Step 1: Select

Seleet with the Mouse, then Change

IF you want o change anything in the patch, there are two steps to follow:

Select the parameter by Clicking on ity carrent value. What do | mean by tha?
Flere™s o oexomple. Suppose you want 1o change the Operator 2 Oulpat Level,
thighlighted below). When you Click on the number 700 (called a conernf), the
mimnber is highlighted (torms white against back), In addition, the name of the
parameter (Op 2 Chutput Level”) appears in the Scroll Bar Window and it current
value is displayed against is possible maximum and minimwm Gn this case 0 and

94y,

Op 2 Qutput Level
Li] b

Step 10 Change

Typing

Seroll ar

Chamge by typing the acw value, 1T you want to change the Operator 2 Ouiput Level
1oy o value of 99, just type 99" on the Macintosh keyboand, When you type the first
“9", the level is set o 9. Then when you type the sccond “9™ the level jumps to 99
Notice that both the scroll bar and the highlighed number change when you type a
number. Now you might think that if you type another “97 the level will go 1o 999
and smoke will begin 1o rise out of your synthesizer. Not so; at this point the
number keys have no effect. However, if you hit either the Return key the or
Enter key, you can type in a new number. ‘The keyboard is also “reset” when you
select (highlight) a differem parameter 1o change.

Chenge by wsing the Scroll Bar. For large changes when vou don’t have a specific
number in mind, the Scroll Bar is the preferred method of changing parameters. In
ndelition, by using the Scrall Tar, you won't have 1o take your hamd off the mouse,
Finally, there are some controls on the screen which contain values other than
mimbers, Since the letter keys are usually reserved for musical perfunmance, these
parameters can only be changed with the Scroll Bar or the Up-Down Amow Cursor,

Up-Thown Arrow Cursor

Change by using the Up Down Cursor, The fasiest and most convenient way o
make small changes to any value is by holding the mouse button down on the
number itself. Aflter you select a parameter for editing (like Operator Output Level)
you will notice that the cursor changes o a thin arrow pointing cither up or down
In the top half of the highlighted box, the cursor points ap, and in the lower balf, the
cursor points down. Il you press the mouse button while the cursor is a thin up
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armvw, the value of the parameter will begin o scroll up by [, and as you would
expect, |‘nrrs.\iug the mouse button wiale the carsor is g downward arrow wall begin
tov serall the value down by |

jhod@

/I\“\

Wel R5e Al
1 0|
Use of the Up and Down Aoow Cursors

Three Ways (o Use the Scroll Bar

Methiwl 1:

Method 2:

Mot 3

Let's ke a closer look at the Scroll Bar, There are thiee different ways 1o use it to
make parsmeter changes,

You can click inside the polka-dot shaded area amd the parmmeter is chamged w reflea
approximately that proponion of the maximum value.  For example, if the cumren
output level of Opermor 2 is a0 99, click about a fourth of the way from i), Yon
should have set the level wo 25 or 30, Novice ifeat the Seroll Bure works differently in
this way than it does ire mose other Macingosh programs.

Eﬂod

-

..-ulllﬂ“
Vel RSe Al
11110/l Op 2 Outpul Level
I Coar Fine Det o 99
r [ : ISﬂ ] [1]

The little arrows on cach side funcion as the + 1 and -1 bottons. 1T you hold the
mouse beitan down on one of them, they cominue w change the current value at a
rate of about 4 steps per second, until you reach the parameter’s maximum or
i value.

Your can also “drag” the thumb around ingide its htle polka dot cage. When you Ll

up the mouse bunon, i°'s as though you clicked at this spot, so this is exactly like the
First method described aleove,
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Fonvelope Window

Perhaps the window that first caught your eye when the program started was the
diagram of the Operitor | envelope. The envelope can be changed by dragging the
“comers” of the dingram around on the screen with the mouse. The mouse cursor
changes 1w a “bombsight” when you move it into the Envelope Window. In order 1o
move 1 corner of the envelope, you have o get the middle of the bombsight inside
one of the boxes located at each corner, then press the mouse button and drap. As
your do this, sotice the Rate and Level numbers (corresponding 1o the comer yon're
moving } change in the Operator 1 Window.

Operator | Envelope Rate 99 [E] Rate 0 3 £
-1 IUTRTTTN D T B e {1 ; £ G

75 o

The Envelope Window

To select the other envelopes Tor editing, just elick on one of the reduced Envelope
representations inan Operator Window.
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Coraphical Keyboard Scaling

The Envelope Window changes inio a large representation of the current settings of
the Keyboard Scaling when you click on the picture in the box below the Envelope,
There are live different parameters you can set using this window, To set the Depih,
¢lick the mouse and drag in the columns of nmmbers on the left and nght sicdes of the
window. To set the Break Poini, simply click on the key you want and it will
“expand.” Note that the black part of the keybonrd represents the current focation of
the physical DX7 keyboard (bascd on the value of Key Transpose). Curve types
{linear or exponentinl) can only be setin the Operaior Window using the Up-Down
Arrovwy Cursor,

Mg The minimture representations of the sealing curves in the Operator Windows do o
indicate whether the curves are linear or exponential, but they do show sign and
depth,

L Operator 3 Keybosrd Scaling R
+ 99 ] 99 +
+ 50 50+
+ 0 T 0 +
"o TIITTITTIILELLS o -
=l 50 -
-99 99 -

Ciraphical Keyboand Scaling wingliss

Conclusion  Sooow you know how to change the values of all the parameters on the sereen, The
most important thing D haven't mentioned yet is that each time yoo make & change,
won ean listen toit Sochita few leners on the Mae keyboard while you're playing
around, Il go get my coffee and then we'll start the next session.
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Creating Sounds

Tt roluction

“Mhis wtorial will go through the same material as the *Let's Actually Create a Vie™
chapter of the onginal DXT manual. Many of you have probably never seci s
manual, but Yamaha never sent me the promised “real” manual and traming cassene,
so it's what 1 used to learn the machine, (It containg a number of wonderful
examples of Japanese-Enplish wanslation) Don’t expect this 1o be a killer sound,
even if | thought it was one (which 1 don’t) T wouldn™t want to incriminate mysell by
admitimg at,

T starl “from scratch™ select the Initialize command from the File menu. This
will initialize the curremily edited voice. Another way you can get the INIT VOICE
is to select 1 New Bank (of DX or TX type) from the Librarian’s File Meou.
Then elick on the Edit button in that window,

Onee you have the INIT VOICE on the screen of the Ealitor, we're teidy o create
our clarinet which will make Pete Fountain green with envy. So, now, let’s actually
Create i voice. ..

Decide on an A tearithem

Locate the number of the algorithm above its icon. Click on the number and then set
the value 1 3 in whatever way you choose. The icon should look like this....

We're only going 1o use Operators | and 2 in this example Voice, Operator | will be
the carrier (you can tell this because it's on the bottom of the algorithm diagram and
also because it says “Car'” next 1o the big number 1 at the top of the Operator
Window). Operator 2 will be the modulator. Which leads us ...
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Prisaie all Operators that are not immediately necessary

There are two ways 1o do this. First, you can click in the Check Boxes at the top of
each Operator window. Or, you can click directly on the elements in the pictune ol
the Algorthm, Since all Operators except | are currently dimmed, there’s no real
weed 1o turn them off, but, just for good measure, let's i off Operators 3 6.
When the box is not checked or the Algorithim picture element 1s gray. I EE S e
sound will come from the Operator.  You can also tell the Operator 15 dlisabled
because the big number at the wp of the window is either pray or dark goay (e
difference will be explained Tater). The INIT VOICE has Operators 2-6 dimmied
because their Output Level is set to () (which is the same as heing tarned off, right!).
Use the Check Box or Algorithin piciure when you want 1o teenporarily wrm off an
Operator - this selting is not saved with the Voice.

1 cor O :E_E_ar [ 3 Mod [J]

TR (L
ﬂ

Vel RS A Vel R5c AM||  [Vel RSe Al
o|lo|o

o[ofa] "[o]e]o
M Coar Fine Det H Coar Fine Det|{ M Coar Fine Det
e[ 1.Joo]o|r[ .00 ]o]|lr] 1.Joo]0]

Temporarly Enabled with Enpbled with
Disabled pon-zero level 2ero level

99

70

Set the Owiput Level of Operator 2 1o a value of 70, Notice that the number “27 irns
black when you do this,

Determine the Carrier Fﬁrqui:nqr

For a ¢larinet, they want the Carrier at 2:1. Use the Coarse Frequency control o do
this. located at the botiom of the Operator | window. You can't type the number of
the frequency you want, The best way 1o change Frequency paramelers is 1o seroll
the value with the Up-Down Armow Cursor.
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Kevhe Carvier e lope

If you click on any of the numbers where the fintle pictore of the Uperator 1 Envelope
shonld be, the Scrall Bar window disappears and all the numbers hecome
hipghlighted. You can also just Click on one of the envelope’s “corners”™ in the
Envelope Window o select the envelope,

99 99 99 39
99 9% 99 0

99

Vel RSe AM
o|lolo
M Coar Fine Ded|
r | 1. Ill.'ll.'l I o

Operator Window showing a selected Envelope

Anything abowt an envelope can be changed by dragging its corners around. We'll
want our carmier envelope 1o look like the picture below. The numbers are shown
above 17 you want i mateh them exactly by using the keyboard. With practice, it's
possible to this with the mouse; it's sort of like wning in a radio station. Drag with
the mouse and watch the numbers in the Operator Window go up and down, Motice
that if you want to change an envelope fevel, you move the cursor vertically, and
when you want to chiange a rate, you move it horizontally, IF you want to change
only a rate or level, hold the Shift Key down before you start (o drag a comer, amnd
you'll only be able w move in the direction you initially stasted in, ‘This is similar ©
the Comstrain use of the Shift Key in MacPaint.
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Most of the time you won’t kiow exactly what numbers you wanl until you're fine
tuning the sound, so don't worry about it if you're a frusteated envelape st at this
point, 17 you feel that you need maore pracuice in band-eye-mouse coordination. iry
some exact geometic drawing in Maclaini. As Susan Kare, graphic designer of the
Macintosh, is quoted as saying, “Fatlis is for sissies,”

EGRate]51|50|51 |55
EGLey |99(95|95| 0

Dperator 1 Envelope

St the Carmigr Envelope 1o look like this
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Sev et Modilateer Puramerers

Froguemey

Envelupe

Fhe Modulator in our example is Operator 2. You can inmediately stan working
with Operator 2 by clicking on what yon want 10 change in its window, We've
already set the Chutput Level, so now we want o set the Freguency o 2060, using: the
Coarse Frequency control. Test the sound w see how clarnet-like it's beecomming

Just for fun, Click on the Fine frequency contral. With Fine frequency, you can
create an trifulrmonic (e, nol an integer) ratio,. Note that as you move the Scroll Bar
to the right o increase the Fine Frequency, the number on the Coarse frequency
starts to change as well. The minirum and maximum values that appear above the
Scroll Bar are those which apply if the current parameter {either Coarse or Fine)
were sel to ils minimum or maximum, nor the absolute masimum passible
frequency. laving these nwo controls is convenient so that you make harmonic
adjustments with the Coarse and inharmonic ratios with the Fine, While your lesm
how these controls operate, make sure 1o try out the effects of different frequency
settings hy typing on the Mac's keyboard, Don't forget 10 set the requency back 1o
200 when you're through exploring. Otherwise it won't sound like a clannet, and
we wouldn 't want thal.

In its nutorial, Yamaha wants you to use the DX7 LG Copy function 1o set the
Mudulitor Envelope, but as this is a Maciniosh, we use the Cliphoand w Copy and
Pagte envelopes, If you pull down the Edit menu when you have an envelope
selected, the Copy Envelope command is highlighted. Click on the linle pictire
of the Operator 1 envelope you so painstakingly created, and select Copy
Envelope. The envelope has now been copied 1o the Clipboard, Now select the
little picture of the Operator 2 Envelope. Now select Paste Envelope as shown in
the figure below,

Hiitn

99 99 99 99

Lt
Copy Envelope
Paste Envelope

99 99 99 0

Lienr o JEelRS: AM
Compare xn M Coar Fine Det

Show Numerical Data 2N _r_l 1. Ir_“] I 1]

Pasting Operator 1's Envelope into Operior 2

Voila! Operator 2's envelope 15 now an exact duplicate of Operator 1's. This feature
doesn’s really come into much use when you are modifying other prople’s patches
(the preferred way 10 start programming) but it's very uselol for mking data from
v vodee and puttiong it into anoiber.
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VO Moadidaasion

Try out the sound. Perhaps vibrato will help. Por this, we will change paramelers
i the Global Window. First, look at the LFOD setings. Yamaha would like you to
set the parameters as shown in the example Global Window below bt Teel Tree 1o
try your own settings, For the LFO Wave, click on the word “Triang!™, and then
chaose from among six dilferent waveforms by changing the Scroll Bar. You
cannot 1ype 8 number 1o change this parnmeter. The other LEO controls all work the
same way as, for example, the Operator Chutput Level parameter.

PEGRat|99 99|99 [99 | LFOWave Spd Del PMD AMD PHMS Syne
PEGLev|50150|50]50 | Triangt [28]36] 0 [ 0] 1 [ 0n

Global Controls: Pitch Envelope and LF(Q Modulation

To hear the effect of the modulation, you must have one of the controls like the
Modulation Wheel on your DX7 set to allow the LFO to control the pich of the
sound, I you don't have a DX7, you can simulate the effect by changing the Pitch
Modulation Depth (PMD) to some non-zero value. 1f you do have a DXT, you can
wirn the Wheel (or whatever) to hear the vibrato, If your DX7 doesa’t seem to be
adding vibrato as you turn the wheel, you'll need o change its Moddulition Wheel
Range (Function 17) to some non-2ero value, and also make sure that Modubition
Wheel Pich (Function 18) is turned on.  If you're using a TX, the Init
“Performance” that was sent o your synthesizer with the INTT VOICE will allow
any modulation wheel 10 add vibrato 1w the sound,
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Right now, INIFT VOLCE is currently the name of our clarinet. Let's call i
surnething a bit warmer and more deseriptive. Click on the words INIT VOICE in
the Cilobal Window, The whole name is selecied, allowing you type a new name in
with the Macinrosh keyboand, Tow about "Maclarinet™, .. One of the cool things
about using a computer with the DX7 is thag the 12X7 (and TX7) LCD wall actually
display lower case! This, to the aesthetically minded among s, 15 a wonderful
improvement. There's quite a high-tech tremd, which 1 believe may have been
started here in Palo Alio, (o capitalize letters in the middle of words, You only have
10} characters to name your voice with, so be laconic. When you select something
else (i.e. another paramerer), the new name is placed in the current Edit Buffer (and
15 also displayed on your synthesizer's LCD il it has one). Ah, but if you pull
down the Voice menu, you will not see the new name replacing INCT VOICE yet (f
only things were so simple. ), Remember that you are editing a copy of the INIT
VOICE, and the original is still safely weked away somewhere else inside your
Micintosh.

Store the voice in the Macintosh memory

Select Store Corrent Edil from the Yoice menu. Now when you save your
Bank or Library file, the new voice will be included. Actually, if you decide 10 save
the file before doing a Store Current Edit, the program does the Store Current
Edit for you.

Save the ﬁ Ie 1 a Macintosh disk

Select Save (if the file already exists) or Save As... from the File menu. You
will be given a standard Macintosh save box. Type a name for your file, and It
Return. The MacLarinet is now soved for future generations on a 3.5 inch Moppy
disk.
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Advanced Lditing

Alaking a Voice wilh two sounds and a split keyvhoard

I this tatorial, we'll take two existing sounds on the supplicd Tutorial Examples file
ol patches, and combine them ine one Yoice, placing one on the lower half of the
keyboard and the other on the upper hall. We'll demonstrate Copying and Pasting
of Operators and an copying an entire Voice within the Editor w reduce the anwnnt
of work it takes to do this sort of task.

i pen the Twtorial Exmn,-:hr.;. file

In the Librarian, choose the Open... command from the File menu. Select cither
X7 or TX (there are Tutorial Examples files of both kinds on the disk). Then open
the Tutorial Examples file on the Editos/Libranan master disk {you're {ree 1o copy
this file—unlike the program itself, it's not copy-protecied!), Alter the lile has been
opened, select voice #20 *StringFlex” and click the Edhit button to start the Editor,

Sor g an Example Sequence

Refore we delve into the workings of this voice, why don't you record an Exmmple
Sequence using Record Example from the Record/Play menu. Because we'll
be testing the split keyboard technigue, you should probably record something
which uses @ wide mnge of notes. You might also want 1o include o varicty of
staccato and legato events as well. Bui remember, you've only ot a lirmited number
of notes available, Have | put enough pressure on you? The importiamt thing 15 just
1o record something, so we can use the automatic playback feature. Afer you're
happy with your Example, enable Play on Parameler Change by selecting it
from the Record/Play menu. OF course at any time during the tutorial, feel free 1o
record something else i